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1 Introduction to Features

Welcome to the Power of InRoads Features workshop. The primary objective of this 
workshop is to explore how InRoads uses features. Features are one of the most 
powerful components in InRoads. Once you understand how InRoads uses and 
stores features, you will be able to take advantage of your knowledge and use 
features for advanced design techniques.

Course Objectives

The objectives of this course are:

• Learn about InRoads features.

• Learn how InRoads stores features.

• Learn how InRoads uses features.

• Learn how InRoads Survey uses features.
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What is InRoads?
The InRoads family of products offers a diverse set of integrated, data-centric, and 
CAD-neutral civil engineering solutions. These applications supply a complete set of 
automated 3D modeling capabilities for infrastructure engineering. Combining civil 
engineering solutions with productivity software, the InRoads family of products 
offers the tools needed to complete any civil design project.

From surveying to design to construction, InRoads includes the features corridor and 
site design projects require. It offers advanced DTM capabilities, associative 
alignments with spiral curves, user-defined typical sections (including superelevation 
and independent slope and ditch control), and parametrically driven decision tables. 
In addition, InRoads makes it easy to build plan and profile sheets, cross sections, 
contour maps, and shaded analytical models to meet project standards.

InRoads enables users to accomplish a variety of projects, such as:

• Road design 

• Corridor design 

• Road widening 

• Road resurfacing 

• Landfill design 

• Building site design 

• Golf course design

• Retention pond design

InRoads is one component of a suite of civil engineering design tools known as the 
InRoads Suite. The base InRoads software discussed in this course is best suited to 
corridor design projects such as roads. The other components of the suite include 
software for site, drainage, and bridge design as well as surveying.

This course uses both InRoads and InRoads Survey.
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What is a feature?
The Webster’s Collegiate Dictionary defines a feature as follows.

feature: the structure, form, or appearance esp. of a person

Although the reference to a person is not pertinent, the remainder of the definition 
accurately describes the concept of a feature in InRoads. In InRoads, a feature 
defines the structure and appearance of elements. 

Which elements? Features relate to elements stored within a Digital Terrain Model or 
DTM in InRoads and to survey data when using InRoads Survey. Since the survey 
data is a common source of the DTM, the two components are closely related.

The structure component of the feature defines how the points behave and relate to 
one another. Using a feature, points with the same characteristics and purpose are 
grouped to electronically replicate real world objects. For example, consider a 
collection of survey points collected along the flow line and the back of a curb and 
gutter section. If each point is independent of each other point, the resulting DTM 
may not accurately model the curb face because the triangulation routine does not 
understand how the points relate to one another. However, when the points are 
grouped as a feature, the points more accurately model the curb face by defining a 
line string along the flow line and another line string along the back of the curb.

The appearance component of the feature defines the symbology (color, weight, and 
so on) used to display the coordinate points. If required per the structure component 
of the definition, the symbology of lines connecting the coordinate points is also 
defined by the feature.

Other examples of features are the edge of a roadway or the bottom of a ditch. 
These features represent either the existing or the proposed roadway. These 
examples of features are all linear connected features (flow line of a gutter or edge of 
a roadway). However, features can also contain related points that are not linearly 
connected. For example, all trees or random elevation shots on a project could be 
collected into a single feature. Although each tree is its own object, and is 
represented individually in the drawings as a cell, the trees are all grouped into a 
single feature in the DTM for easier tracking and management of the data.

As you will see throughout this course, InRoads features are at the core of virtually 
every process in the software from importing survey data, through design, cross 
sections, profiles, and reporting. Features are the backbone of the InRoads DTM.
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InRoads Feature Terminology

InRoads and InRoads Survey use the term feature to refer to a number of different 
components of the software. Below are brief definitions of four different uses of the 
term feature you will encounter when using InRoads. We will continue to discuss 
each of these in more detail throughout the course.

Survey Feature – Survey features define how elements appear in the graphics file 
when they are imported from raw data sources, such as data collectors, and 
processed with InRoads Survey. 

In addition to the appearance definition, the survey feature also contains parameters 
about the contents and purpose of the survey data. For example, how a point should 
be connected to previous points, and which codes a surveyor can use to collect a 
point that InRoads will interpret as this feature. 

Survey Features are defined in a .xinfile.

Feature Code – The term feature code is frequently used to refer to the the code a 
surveyor enters into a data collector to identify a survey coordinate. The feature code 
is matched to the survey feature name when the survey data is imported using 
InRoads Survey.

Feature – InRoads uses the term feature to refer to the contents of a Digital Terrain 
Model or DTM. Every coordinate in a DTM is part of a feature. The features within 
the DTM define how each point behaves and how it influences the triangulated 
model resulting from the DTM. The DTM feature indirectly defines the appearance of 
the graphics by linking to a surface feature.

Features are stored in the .dtm file.

Surface Feature – Surface Features define how a point or a series of points can be 
displayed in the graphics file. For example, can the feature be displayed in plan view, 
profile view, or cross section view. The surface feature links to a named symbology 
definition that defines the appearance of the graphics.

Surface feature and named symbology are both stored in the .xin preference file.

Feature Type – The feature type defines if the structure of the feature is individual 
points, linear or a closed area. This definition controls how features affect the 
triangluated model.
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The following illustration shows the relationship of InRoads features and the 
associated feature preferences in the InRoads Survey and InRoads software.

Relationship between InRoads Features

As you can see in the illustration, there are two distinctly separate uses of Features 
within the InRoads software. The primary objective of this course is to understand 
how InRoads uses features in the DTM. However, a brief understanding of how 
InRoads Survey uses features and how the Survey Features relate to and become 
DTM Features is important.

Therefore, the following chapters discuss both Survey Features and Surface 
Features.
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Feature Types
A common component of both Survey Features and Surface Features is the feature 
type, or point type (InRoads uses both names interchangeably) the feature 
represents. A feature defines the structure of the coordinate points that belong to the 
feature. Ultimately the coordinate points are used to create a DTM. The feature type 
specifies how the coordinate points are interpreted and related to each other within 
the DTM. InRoads supports five point types; Random, Breakline, Contour, Interior 
Boundary, Exterior Boundary, and Do Not Triangulate.

Random Points – Random points, also called spot points, represent non-uniformly 
spaced points that have no directly relationship to other points. When a triangle 
model is created from random points, the DTM system determines how to connect 
the points based on its algorithm. Triangulating random points typically results in a 
less accurate model than one created using breakline point types. Random points 
are typically used to supplement breaklines.

Random points triangulated

Breakline Points – Breakline points represent a linear discontinuity in a surface 
such as a ridge, ditch, edge of pavement, or curb. The breakline feature type 
specifies that all points in the feature are connected into a linear segment. When the 
DTM model is created, the triangles are formed so that no triangle crosses any 
breakline segment. Therefore, the breakline holds a linear relationship that might 
otherwise be lost during triangulation.
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In the following illustration, the random points are replaced by breaklines passing 
through the same locations as the random points. The resulting triangles more 
accurately model the linear relationship of this segment of a roadway.

Breakline points triangulated

Contour Points – Contour points behave exactly the same as breaklines. Contour 
points are special breaklines where all of the points in each contour line are at the 
same elevation.

Interior Boundary Points – Interior boundary points represent undefined areas in a 
DTM. For example, the footprint of a building or body of water is specified as an 
interior boundary. No triangles are created inside the interior boundary. The interior 
boundary must be a closed shape. A DTM can have more than one interior boundary 
but they must not overlap.

Interior Boundary points triangulated

Exterior Boundary Points – Exterior boundary points represent the outer extent of 
the DTM. No triangles can exist outside of the exterior boundary. The exterior 
boundary must be a closed shape. Only one exterior boundary can exist in a DTM.
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Do Not Triangulate – Sometimes it is desirable to include points in a DTM that do 
not influence the surface model. For example, underground utilities and other 
planimetrics can be included in the DTM even though they do not contribute to the 
surface model.

Why include points in the DTM that do not contribute to the surface model?

InRoads can display any feature in the DTM in plan, profile, or cross section views. 
Therefore, including planimetrics features such as utilities and fences in the DTM 
allows those elements to be easily shown on cross sections and profile views as well 
as in the typical plan view display.
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2 Overview of Survey Features

One of the first tasks on a project is to create a DTM and planimetrics representing 
the existing conditions. The existing conditions are surveyed using applicable survey 
methods such as photogrammetry and field collection. Once collected, the survey 
data is processed and prepared for the designers by defining both alignments and 
surface models (DTMs). 

The easiest and most robust method to import survey data into InRoads is to use the 
InRoads Survey application. Using InRoads Survey, the raw data from the survey 
data collector is imported, processed, and the DTM created in a mostly automated 
workflow. 

In this chapter you will:

• Learn to import raw survey data.

• Learn how Survey Features work.

• Learn how Survey Features are defined.

• Learn to Export Survey data to a DTM.

This chapter is a brief overview of, and introduction to, InRoads Survey. The purpose 
of this training is not to teach you how to use InRoads Survey, but instead to expose 
you to the power of the Survey tools and demonstrate how Survey Features relate to 
DTM Features.
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Importing Survey Data
Field collected survey data is typically stored using a data collector. The format of the 
data in the data collector is specific to the vendor of that survey equipment. InRoads 
Survey includes the ability to read from most vendor formats. When the data is 
collected in the field, the surveyor identifies each point with a code commonly 
referred to as a feature code. The feature code is either an ASCII or numeric code 
that designates the purpose of the coordinate to the surveyor.

Ultimately, the feature code is the link between InRoads and the field surveying 
operation. Prior to importing the survey data, survey features are setup in the 
InRoads Survey software. The survey features include the feature code definitions, 
thus providing the link between the field survey and InRoads. When the raw field 
survey data is loaded into InRoads, the feature codes are compared to the available 
survey features. If a match if found, InRoads imports the field survey coordinate point 
and links it to the matching survey feature.

InRoads Survey Import Workflow

As illustrated above, the imported survey data is written to the Survey Data file 
(.fwd). However, imported data passes through, and is linked to, the Survey Features 
in the .xin preference file to establish its behavior and symbology.
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Setup Lab Files

Before we can begin the lab exercises, MicroStation and InRoads must be started 
and setup for the course exercises.

EXERCISE: START MICROSTATION AND INROADS

1 Start InRoads and MicroStation by selecting the InRoads icon on the desktop or 
on the Start menu.

If MicroStation and InRoads are running from a previous session, close them and 
restart them to assure the proper lab files are being used.

2 Open the MicroStation file 
c:\BE Data\Civil\C1TNC109\Data\Feature Training.dgn.

3 Select the Product Add-ins tool (Tools > Product Add-Ins).

4 Locate and enable the InRoads Survey option.

5 Click OK.

The InRoads Survey software is enabled. One new menu item named Survey is 
added to the InRoads menu.

EXERCISE: LOAD PROJECT DATA

1 Load the InRoads project
c:\BE Data\Civil\C1TNC109\Data\Feature Training.rwk.

The project file loads the following files into InRoads:

Existing Ground.dtm
Feature Training.alg
Feature Training.ird
Feature Training.itl
Feature Training.fwd
Feature Training.xin

2 Enable the Write lock.

3 Set the Pen/Pencil lock to Pencil mode.
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Import Survey Data
Survey data can be imported from many different file formats. For this exercise, the 
data is loaded from a TDS file format. A small sample of the TDS file to be imported 
is shown below. This data is ASCII data downloaded directly from the TDS data 
collector.

JB,ROUTE70BRIDGE,DT04-27-1999,TM13:01:59
SP,PN1,N 835902.3753,E 3556583.0151,EL150.0262,--PC
SP,PN2,N 835977.3885,E 3558285.6102,EL143.2874,--PC
OC,OP1,N 835902.3753,E 3556583.0151,EL150.0262,--PC
BK,OP1,BP2,BS87.283824,BC0.000000
LS,HI5.1181,HR4.9213
SS,OP1,FP2,AR0.000000,ZE,SD,--PCP
SS,OP1,FP100,AR0.480000,ZE90.520500,SD338.1266,--TOPT
AT,TNSIZE,TV60d
AT,TNMATRL,TVNAIL
SS,OP1,FP101,AR1.092000,ZE90.434500,SD489.3012,--TOPT
AT,TNSIZE,TV60d
AT,TNMATRL,TVNAIL
SS,OP1,FP102,AR1.312500,ZE90.375500,SD636.6995,--TOPT
AT,TNSIZE,TV60d
AT,TNMATRL,TVNAIL
SS,OP1,FP1000,AR239.211500,ZE85.405000,SD70.0984,--ROWM
AT,TNSIZE,TV0.10M X 0.10M
AT,TNMATRL,TVCONCRETE
AT,TNOWNER,TVLDH
OC,OP100,N 835912.5390,E 3556920.9501,EL145.1004,--TOP
BK,OP100,BP1,BS268.163824,BC0.000000

The data in the TDS file is formatted by the data collector vendor. Although this file 
would not be reviewed or edited in a standard workflow, let’s examine the file briefly 
to understand a little about its contents.
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The lines that begin with ss are coordinate points collected by the field survey crew. 
Each line contains multiple parameters separated by commas. Consider the 
following line.

SS,OP1,FP1000,AR239.211500,ZE85.405000,SD70.0984,--ROWM

The meaning of each parameter is described below.

SS – Defines this is a side shot.

OP1 – The occupied point (location of the survey instrument) is a point named 1. The 
location of point 1 was previously established.

FP1000 – The name of the new point is 1000.

AR239.211500 – The horizontal angle (turning to the right) from the established 
backsight point to the point 1000 is 239.211500 degrees.

ZE85.405000 – The vertical (zenith) angle from straight up to the point 1000 is 
85.405000 degrees.

SD70.0984 – The distance between the survey instrument and the point 1000 is 
70.0984 feet.

ROWM – The field surveyor has designated this point as a right-of-way monument. 
The code ROWM is a code the surveyor and the InRoads operator have agreed to 
use for this type of point. ROWM is referred to as the Feature Code.

When this file is imported into InRoads, each line is resolved and its Feature Code 
matched to an InRoads Survey Feature. 
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EXERCISE: IMPORT SURVEY DATA

Continue from the previous exercise.

1 Select the Import Survey Data tool (File > Import > Survey Data).

2 In the Files of Type list, select TDS (*.rw5).

3 Select the file Feature Training.rw5.

4 Click Import.

Be careful to only click import once. Each time Import is clicked, the data is 
imported. If import is clicked more than one, duplicate data is loaded.

5 Click Close.

The survey data is processed and may be displayed on the screen depending on 
your settings. If you do not see any graphics on the screen do not worry. That will 
be corrected shortly.

6 In the InRoads Explorer window, select the Survey tab.

7 Select Feature Training in the left pane of the InRoads Explorer window.

The reduced survey data is shown in the right pane of the InRoads Explorer 
window. Notice the data has been reduced from its format in the raw data file and 
is presented in coordinates and elevations.

InRoads Explorer dialog box with Occupied Points in the Right Pane

The points shown with the survey instrument icon to their left are the occupied 
points or the locations where the survey instrument was located. Recall that point 
1000 was collected as a side shot from an occupied point named 1000.
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8 Click 1 in the left pane of the InRoads Explorer window.

InRoads Explorer dialog box with Side Shot points in the Right Pane

9 Review the point 1000 in the right pane.

Notice the coordinate of the point are displayed. These coordinates were 
calculated by InRoads as the survey data was imported.

The Code column shows the feature code assigned to the point in the field. In this 
example, the code is ROWM.

EXERCISE: DISPLAY SURVEY DATA

1 Select the View Planimetrics tool (Survey > View Survey Data > Planimetrics).

The imported survey data displays on the screen. Selecting View Planimetrics 
again disables the display. The graphics is only temporary showing the current 
status of the survey data allowing necessary review and corrections before 
exporting the data to a DTM and geometry project.

2 Zoom into the survey data and review the graphics. 

Notice how different components of the survey data are symbolized differently. 
Different colors and line styles represent different features. Also notice that some 
features are linear (line strings) and others are points (cells or text).

3 The other tools under the Survey > View Survey Data menu display other aspects 
of the survey data. For example, the Code tool displays the feature codes.

4 The tool Survey > View Survey Data > Write Survey Data to Graphics creates 
permanent graphic representations of the survey data into the CAD file.

If you wrote the survey data to the CAD file, please select all of the graphics and 
delete it before continuing.
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Survey Features

What is a Survey Feature?

Survey Features are the link between the survey data and InRoads. The survey 
feature defines how the feature is displayed, how it connects to other features, and 
how it behaves when included in a DTM or geometry project.

Survey features are stored in the InRoads Preference or .xin file. To access the 
Survey Features, select Tools > Style Manager. The following dialog box appears. 
Select only the Include Survey option in the upper left corner to view only the Survey 
Features.

Style Manager showing survey features



© 2006 Bentley Systems, Incorporated 19

2006 BE Conference
The Power of InRoads Features

The Style Manager dialog box shows all of the survey features that exist in the active 
.xin file. Select a feature and click Edit, or double click on a feature, to access the 
Edit Style dialog box.

Edit Style dialog box

The Edit Style dialog includes settings for InRoads Surface, Geometry and Survey 
features. During this exercise we are focused on the Survey Features. There are five 
leaf views (Settings, Symbology, Codes, Attributes, Custom Operations) associated 
with the Survey Feature branch. The parameters on each leaf are discussed briefly 
below.
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Settings Leaf
Feature Type – Designates how points linked to this survey feature will be 
triangulated when they are exported to a DTM. Valid point types include; Random, 
Breakline, Contour, Interior, and Exterior. Refer to chapter 1 for more details on 
Feature Types.

Exclude from Triangulcation – When enabled, the resulting surface features will 
not be included in the triangulated surface model.

Options – Specifies how lines are drawn connecting sequential points linked to the 
same survey feature.

Symbology Leaf
Defines the Named Symbology definition used to display the feature and connecting 
lines.

Codes Leaf
Numeric Code – A numeric code field surveyors can use to link a survey point to a 
survey feature definition. Only one numeric code can exist for a survey feature.

Alpha Code – One or more alphabetic codes field surveyors can use to link a point 
to a survey feature definition.

Attributes Leaf
User defined attributes that can be collected during the survey using some data 
collectors. The attributes can be used by InRoads Survey to affect the display of the 
feature or as supplemental information about the feature.

Custom Operations Leaf
Definitions of custom activities that will occur when a feature is displayed.

Editing Survey Features

EXERCISE: EDIT SURVEY FEATURE

Continue from the previous exercise.

1 Ensure that the planimetrics are displayed and all other types of survey data 
displays are disabled.

2 Select the Style Manager tool (Tools > Style Manager).

3 Enable the Include Survey option.
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4 Locate and select the ROW MON feature.

Click on any column heading in the Style Manager dialog box to sort the contents 
of that column.

5 Double click the feature name to open the Edit Style dialog box.

6 Select the Survey Feature > Codes leaves.

7 Observe that this feature has a single Alpha code named ROWM. This is the 
code that point 1000 became linked to when it was imported into InRoads.

8 Click Cancel to close the Edit Style dialog box.

9 Locate and select the FENCE LINE feature.

10 Click Edit.

The Edit Style dialog box appears.

11 Select the Survey Feature > Symbology leaves.

12 Click Edit.

The Edit Named Symbology dialog box appears.

13 Select Plan Line and click Edit.

The Line Symbology dialog box appears.

14 In the Line Style field, select {Rail Road}.

Changing the Line Symbology changes how any survey data associated with this 
feature is displayed.

15 Click OK on the Line Symbology dialog box.

16 Review the graphics and locate the yellow lines using a diamond line style along 
each edge of the roadway. These lines represent the fence and are linked to the 
FENCE LINE feature.

17 Click Apply on the Edit Named Symbology dialog box.

The yellow fence line immediately updates from the diamond line style to the rail 
road line style. This demonstrates the linkage between the survey feature and the 
survey data.

18 Set the line style associated with the FENCE LINE feature back to {Diamond}.

19 Close the Edit Named Symbology, Edit Style, and Style Manager dialog boxes.



© 2006 Bentley Systems, Incorporated 22

2006 BE Conference
The Power of InRoads Features

Exporting Survey Data to a DTM
After appropriate corrections and adjustments are made to the survey data, it is 
exported to an InRoads DTM or geometry project. Once exported to a DTM or 
geometry project, the Survey Features are no longer used. 

The Survey Features are only used while the data 
is being processed by the InRoads Survey software.
Once the data is stored in a DTM or geometry project, a different “feature” definition 
is used. There are actually two definitions, one for the DTM data and another for the 
geometry project data.

InRoads uses Surface Features to define the “feature” properties of elements 
contained in a DTM. Surface Feature are stored in the .xin preference file. Geometry 
project data rely on geometry styles for their symbology definitions. Geometry styles 
are also stored in the .xin preference file.

When data is exported from InRoads Survey to a DTM or geometry project, InRoads 
uses the commonly named Survey Features, Surface Features and Geometry 
Features. If appropriate definitions exist, the data is linked to the respective style. If 
no match is found, the data is linked to the default style.

The following illustration shows the division between InRoads Survey and InRoads. 
As the data is exported from the Survey Data file (.fwd), it is sent to either a DTM or 
a geometry project.

Survey Export to DTM and Geometry Project Data Flow
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When survey data is sent to a geometry project, the Style name is used to find a 
matching Geometry Feature style in the .xin preference file.

The Style name is used to locate a Geometry Style
when Survey Data is exported to a geometry project

When survey data is exported to a DTM, InRoads attempts to match one of three 
survey feature parameters to a feature style. Which survey feature parameter is 
matched is controlled on the Survey Data to Surface dialog box.

Survey Data to Surface dialog box
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The Always Use parameter controls which Survey Feature parameter is matched to 
the Surface Feature. There are three options.

Style – The style name is matched to the Surface Feature.

Alpha Code – The first Alpha Code parameter is matched to the Surface Feature.

Numeric Code – The Numeric Code parameter is matched to the Surface Feature.

The Style name, alpha code, or numeric code is used to match a
Surface Feature when Survey Data is exported to a DTM

If there is not a Surface Feature that matches the specified parameter from the 
survey feature, the Surface Feature named default is assigned to the data.

If the Always Use parameter is disabled, InRoads attempts to locate a match using 
the first non-blank parameter. The parameters are searched in the following order. 
Style first, then Alpha Code, followed by Numeric Code.
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EXERCISE: EXPORT SURVEY DATA TO DTM

Continue from the previous exercise.

1 Select the Survey Data to Surface tool (Survey > Survey Data to Surface).

2 Set the following parameters on the dialog box.

Surface Name: Survey

Description: Use Style Description

Tolerance: 0.0000

Maximum Segment Length: 0.0000

Curve Stroking Mode: Horizontal and Vertical

Always On: Enabled, Style

Triangulate Surface: Enabled

3 Click OK.

The data is exported to the DTM and the Triangulate Surface dialog box appears.

4 Click Apply on the Triangulate Surface dialog box.

5 Click Close on the Triangulate Surface dialog box.

The new DTM is created. 

We will review the contents of this DTM in the following chapter.
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3 DTM Features

The InRoads DTM is a very powerful tool. In its most basic since, the DTM stores the 
coordinate data (random points, breaklines, and so on) that defines a ground 
surface. However, a thorough understanding of the “features” stored in the DTM 
enable more advanced uses of the DTM data beyond simply storing the surface 
model.

In this chapter you will:

• Learn how InRoads stores a DTM.

• Learn how to view DTM data.

• Learn how to create a DTM.

• Learn how to use a DTM
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What is a DTM?
The InRoads DTM is really quite simple. It is a database of coordinates (often linked 
together into line strings or shapes) that represent real world objects. The most 
common use of the DTM is to model a ground surface.

For example, an existing ground DTM would likely contain line strings along all major 
breaks in the terrain such as the edges of the roadway, bottoms of ditches, edges of 
waterways, and so on. In addition, shapes may be included to define areas where 
reliable data is not available such as inside the perimeter of a pond or a building. 
Finally, random or spot points are included to supplement the data with additional 
elevations.

A proposed design DTM would include line strings along the linear features of the 
roadway such as the edge of roadway, ditches, and so on.

When these coordinate points are connected together or triangulated, the result is a 
three-dimensional model of a terrain surface similar to that shown below.

Digital Terrain Model

Many different software packages use DTM’s to store terrain data and most do it in a 
similar fashion. Although the algorithm used to triangulate the surface may vary, the 
basic definition is similar using points, line strings, and shapes.
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Many civil design tools use a Triangulated Irregular Network (TIN) as their DTM 
model. While the TIN model provides an accurate terrain model, it is limited in its 
usage beyond the model. The coordinate points, line strings, and shapes are loaded 
into the DTM and triangulated. However, once they are loaded, the DTM does not 
store any information about origin or purpose of each coordinate. For example, the 
DTM cannot distinguish between a line string representing a curb and a line string 
representing a fence. Since the DTM cannot tell one line string from another, the 
DTM cannot graphically display the individual DTM elements symbolized to 
represent the purpose of the element.

However, the InRoads DTM is different. It is a feature based DTM. A feature based 
DTM not only stores the coordinate data, but also feature data (structure and 
appearance) with each element stored in the DTM. Since the feature data is included 
with the elements in the DTM, each element can be evaluated or displayed using 
appropriate symbology. For example, when the DTM features are displayed, a water 
line will look different from an edge of pavement or a curb line.

The InRoads DTM can also store data that does not contribute to the terrain surface 
but is valuable to the design process. For example, the location of a culvert, 
waterline, or guardrail can be stored in the DTM even though these elements sould 
not be included in the surface model. Since the DTM stores the true three-
dimensional location of all points, utility or planimetric data is also stored in its true 
three-dimensional location.

There are many benefits to storing data in the DTM that does not contribute to the 
terrain surface. First, any data in the DTM can be displayed in a plan view, profile 
view or cross section view. Therefore, it is very simple to show the location of a 
waterline or guardrail in the plan view as well as on the profiles and cross sections if 
the data is included in the DTM. Another uses of including the data in the DTM is for 
design decisions. For example, if the right-of-way line is stored in the DTM, the 
roadway modeler can make decisions to determine the best side slope so that the 
toe of the slope does not fall outside of the right-of-way.
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What is a Feature?
InRoads uses the term feature to describe an element in a DTM file. Every element 
in the DTM belongs to one and only one feature. A feature is a named set of 
coordinate points in a DTM. By itself, a coordinate point is just that, a single location 
in space unrelated to all other points. However, when a set of related points is 
grouped into a feature the result has far more meaning than the points themselves. 

The grouping defines which points to connect together, the linear relationship of the 
points, and the order of the points. Most importantly, the feature identifies the 
purpose (structure) and graphical display (appearance) of the points.

Although the feature is stored in the DTM, not all of the feature parameters are 
stored in the DTM. The feature parameters are stored in both the DTM and the .xin 
preference file. The feature parameters are distributed across the two files so that 
common parameters can be reused without duplicate setup.

The feature parameters are divided into three sets; the feature, the feature style, and 
named symbology.

The feature is stored in the DTM and defines the parameters unique to a single 
feature as well as a linkage to a feature style.

The feature style is stored in the .xin file and defines where a feature is graphically 
displayable. However, the feature style does not define the symbology used to draw 
the feature. It only defines if a feature can be displayed in plan, profile, or cross 
section views. The feature style is linked to a named symbology.

The named symbology defines the graphic symbology used to display the feature. 
Separate symbology is defined for the plan, profile, and cross section display of a 
feature.
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The following illustration shows the relationship between the different feature 
parameters.

Relationship between Feature, Surface Feature, and Named Symbology
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Feature

The Feature Properties tool (Surface > Feature > Feature Properties) is used to view 
and edit the features stored in the DTM file.

Feature Properties dialog box

The Surface parameter specifies the DTM surface displayed in the other fields on the 
dialog box.
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The Feature area lists the individual feature stored in the surface. Remember, all 
coordinate points must be stored in a feature. To view the coordinate points that 
belong to a feature, select the feature and click the List Points button.

Results dialog showing the coordinate points that belong to the EOP feature

It is common to have multiple features that represent the same type of element in a 
surface. For example, in the Survey surface, there are four edge of pavement 
features named PAVEMENT EDGE# where # is a number.

The Style column in the Feature area shows the Surface Feature style linked to the 
respective feature. In the example, all four edge of pavement features are linked to 
the feature style named PAVEMENT EDGE. In this case, the feature name and the 
style name were substantially similar. However, the names do not need to be the 
same or similar.

There are many reasons for having multiple features linked to the same feature style. 
For example, if the field survey crew was unable to collect the entire area in one 
session, they may have started with new features when they began each session or 
day. Another reason may be discontinuous features. The exercise project includes a 
bridge. Therefore, there are two edges of pavement (left and right side of the road) 
from the beginning of the project to the bridge. Two more edges of pavement are 
needed to define the road from the end of the bridge to the end of the project. A 
major benefit of separating the feature style from the feature is that the surface 
feature style is reusable on multiple projects even though the DTM file for each 
project is different.

When the desired feature is selected from the feature list, the name, description and 
parent of the feature appear in their respective fields on the dialog box. The feature 
can be renamed, a description or parent added at any time.
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The parent parameter is used to group together multiple features for reporting or 
processing. By default, most InRoads actions leave the parent parameter blank. 
However, the parent parameter for features generated by the Roadway Designer is 
automatically set to Alignment. A feature filter is needed to process groups of 
features based on their parent parameter. Feature filters are discussed later in this 
course.

At the bottom of the dialog box, in the Triangulation area, are parameters that define 
the structure of the feature. The first parameter is the Feature Type. Feature Type 
specifies how (breakline, random point, interior boundary, …) a feature is included in 
the triangulated model. Chapter 1 includes a discussion of the different feature 
types. Enabling the Exclude from Triangulation parameter, tells InRoads to not 
include the selected feature when building the triangulated model. The feature is still 
available for display and design decisions but does not affect the surface model. A 
common use of this parameter is to store utilities, fences, vegetation, and other 
planimetric features that do not directly influence the terrain. For example, a 
waterline is below the ground. If the water line feature is included in the triangulated 
model, the model would have a hole or cavern along the water line. Excluding the 
water line from triangulation allows it to exist in the model but not affect the terrain.

The Point Density Interval parameter increases the density of triangle vertices so 
that no triangle has a side that is longer than the specified value. Models with 
shorter, more uniformly sized triangles result in a better model. A value of zero 
causes the model to be generated using only the coordinate points stored in the 
surface, no densification occurs. Any other value, causes triangles to be densified 
until the maximum length of any triangle edge equals the point density interval.

The final area on the dialog box is the Style setting. This area defines the linkage to 
the feature style stored in the .xin preference file. The list on the left shows all 
available styles. The list on the right shows the feature styles currently linked to the 
active feature. A feature can be linked to more than one feature style. For example, 
you may choose to designate a fence line as both a fence style and a right-of-way 
style. Then, InRoads would match this feature when searching for both fence and 
right-of-way feature syles.

If a feature is associated with more than one feature style, the feature style at the top 
of the list (known as the Primary style) defines how the feature is displayed 
graphically.
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Viewing Features

The features in a surface are displayed using the View Features tool (Surface > View 
Surface > Features). 

View Features dialog box

EXERCISE: VIEW SURFACE FEATURES

Continue for the previous exercise.

1 If any graphics are displayed from the previous exercises, delete them and 
disable the InRoads Survey display options (Survey > View Survey Data > …).

2 Select the View Features tool (Surface > View Surface > Features).

3 In the Surface field, select Survey.

Survey is the name of the surface previously exported from InRoads Survey.

4 Select all of the features in the Features list.

Use the CTRL and SHIFT keys to select multiple features or click the All button to 
select all of the features.
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5 Click Apply.

The features are displayed in the graphics file. Notice that these features appear 
the same as the features displayed with InRoads Survey. Since InRoads Survey 
and InRoads are both using .

InRoads Survey relies on the Survey Feature (.fwf) file to define the display 
symbology of the features. The InRoads DTM relies on the Feature Style (civil.ini) 
file for the display symbology. In this example, care has been taken to keep the 
survey features and the feature styles synchronized so that they data appears 
the same. 

6 Click Close.

EXERCISE: EDIT FEATURE PROPERTY

Continue from the previous exercise.

1 Zoom into the graphics so that the road segment left of the bridge is visible.
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2 Select the Feature Properties tool (Surface > Feature > Feature Properties).

3 In the Surface field, select Survey.

4 Select the target button next to the Feature list.

5 Locate and select the fence line along the bottom of the road. The fence line is 
the yellow line with the diamond line style pattern.

6 Data point to accept the fence line.

The feature FENCE LINE is selected in the Feature Properties dialog box. 
FENCE LINE is the name of the feature that contains this fence segment.

7 In the Style area set Primary to WATERLINE.

8 Click Apply.

The feature FENCE LINE is redefined and linked to the feature style named 
WATERLINE.

9 Click Close.

EXERCISE: UPDATE FEATURE DISPLAY

Continue from the previous exercise.

1 Select the View Features tool (Surface > View Surface > Features).

2 In the Surface field, select Survey.

3 Select all of the features in the Features list.

You could select only the feature named FENCE LINE since that is the only 
feature that was modified. However, it is easier to just re-display all of the 
features.

4 Click Apply.

The fence line feature display is updated to represent a water line. The water line 
displays as a light blue line with a dash dot dot dot line pattern.
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EXERCISE: RESET FEATURE PROPERTY

Continue from the previous exercise.

1 Use the Feature Properties tool to reset the feature FENCE LINE to link to the 
feature style FENCE LINE.

2 Use the View Features tool to update the feature display. The fence will again 
display in yellow using a diamond line style.

Surface Feature

The feature (defined in the DTM) is linked to a surface feature. The surface feature 
defines where a feature is displayable. The surface feature also has a link to a 
named symbology that defines the graphical symbology of the feature. 

Surface Features are stored in the .xin preference file and are defined using the 
Style Manager tool (Tools > Style Manager). The Style Manager dialog box lists all of 
the available features.

Style Manager dialog box
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Select a surface feature name and click Edit or double click on a surface feature 
name to edit that surface feature.

Edit Style dialog box

The name of the surface feature appears but is not editable in the Edit Style dialog 
box. To edit a surface feature name, use the Rename button on the Style Manager 
dialog box. 

The Attach Tag option on the Edit Style > General leaf defines if a MicroStation tag is 
attached to the graphic elements displayed in plan view. MicroStation tags are non-
graphical information stored with an element. InRoads generates a MicroStation tag 
that contains the type of feature, its name, and its origin.

The tag data has several uses. First, each graphic element has data associated with 
it that is easily reviewable using MicroStation tools. Another use of tags is when 
graphic elements are imported into InRoads. If the graphics have the appropriate 
tag, InRoads automatically understands pertinent information about the element. For 
example, if features are displayed graphically and later loaded back into a DTM, 
InRoads reads the tag data on each element to determine the feature name of the 
element and its feature type (breakline, random point, …).

Select the Surface Feature branch to view the parameters associated with surface 
features. There are two leafs under the Surface Features branch.
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The symbology leaf specifies the link to a named symbology definition. The named 
symbology definition stores the symbology (color, weight, and so on) used to display 
the feature. Existing named symbology definitions are selected from the drop down 
list. The New and Edit buttons are shortcuts to access the Edit Named Symbology 
dialog box. The named symbology settings are discussed in more detail below.

The Pay Item parameter on the Settings leaf is an optional attribute that can be 
assigned to a feature style. If assigned, the Pay Item can be used to select features 
to be processed or reported on using Feature Filters and XML Reporting. Feature 
Filters are discussed later.

The remainder of the leaf is divided into three areas; plan, cross section, and profile. 
Each area includes toggles to specify if and how a feature can be displayed in the 
respective view orientation.

3-D/Plan Display Parameters 

The 3-D/Plan Display area specifies how each feature is displayed in a plan view 
drawing. There are four parameters as described below.

Line Segments – When enabled, the linear component of the active feature is 
displayed in the plan view using the View Feature tool. Features with connected 
points such as breaklines and interior boundaries have a linear component. An 
example of a linear feature is a fence line.

When disabled, linear features are not displayed in the plan view.

Points – When enabled, the point component of a feature is displayed in the plan 
view using the View Feature tool. All features have point components. Random 
features have a point at each coordinate value. Linear features, such as breaklines, 
interior boundaries, and exterior boundaries, have point components at each vertex.

When disabled, point features are not displayed in the plan view.

Annotation – When enabled, features are annotated in the plan view using the 
Annotate Feature tool.

When disabled, features are not annotated.
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EXERCISE: DISABLE PLAN VIEW FEATURE DISPLAY

Continue from the previous exercise.

1 Select the Style Manager tool (Tools > Style Manager).

2 Locate and select the FENCE LINE feature.

3 Click Edit.

The Edit Style dialog box appears.

4 Select the Surface Features > Settings leaf.

5 Disable the Line Segments parameter in the 3-D/Plan Display area.

6 Click Apply.

7 Click Close to close the Edit Style dialog box.

8 Click Close to close the Style Manager dialog box.

9 Delete all graphics in the CAD file.

10 Use the View Features tool to view all features in the Survey surface.

None of the fence features are displayed. The fence features were the yellow 
lines using the diamond line style.

The fence lines are no longer displayed because the ability for them to display 
was disabled in the feature style.

11 Close the View Features tool.
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EXERCISE: ENABLE PLAN VIEW FEATURE DISPLAY

Continue from the previous exercise.

1 Select the Style Manager tool (Tools > Style Manager).

2 Locate and select the FENCE LINE feature style.

3 Click Edit.

The Edit Feature Style dialog box appears.

4 Select the Surface Features > Settings leaf.

5 Enable the Line Segments parameter in the 3-D/Plan Display area.

6 Enable the Points parameter in the 3-D/Plan Display area.

7 Click Apply.

8 Click Close to close the Edit Feature Style dialog box.

9 Click Close to close the Feature Style Manager dialog box.

10 Use the View Features tool to update all features in the Survey surface.

The fence features appear because the ability for them to display has been 
enabled again in the feature style. In addition, a red circle appears at each vertex 
along the fence features. The red circles appear because the ability to display 
points in the plan view is now enabled in the feature style.

11 Close the View Features tool.

Annotate Feature

The Annotate Feature tool (Surface > View Surface > Annotate Feature) places 
annotation text at feature points and along linear features. However, before a feature 
can be annotated, the annotation parameter must be enabled in the feature style.

The Annotate Feature tool has several options specifying what (north coordinate, 
east coordinate, elevation, feature name, and so on) gets annotated and where the 
annotation is located relative to the feature.
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EXERCISE: ANNOTATE FENCE LINE FEATURE

Continue from previous exercise.

1 Select the Annotate Feature tool (Surface > View Surface > Annotate Feature).

2 Select the Main tab.

3 In the Surface field, select Survey.

4 Browse through the feature list.

Notice that all of the features in the surface are listed. However they are all 
dimmed and unavailable.

The features are all unavailable because the Annotate parameter in the feature 
style linked to each of the features is disabled.

5 Locate and select a feature using the FENCE LINE feature style.

6 Click Edit Style.

The Edit Style dialog box appears. The Edit Style button is a shortcut to the Style 
Manager.

7 Enable the Annotate parameter in the 3-D/Plan Display area.

8 Click Apply on the Edit Style dialog box.

9 Click Close on the Edit Style dialog box.

10 Browse through the feature list again.

Notice the FENCE LINE features are now black and available for annotation. All 
four of these feature names are linked to the FENCE LINE feature style.

11 Select the four features that use the FENCE LINE feature style.

12 Disable the Line Segments parameter.

13 Enable the Points parameter.

The Points and Line Segments tabs define what attributes are included in the 
annotation and where they are position relative to the feature. For this exercise 
we will accept the defaults.

14 Click Apply.

Each vertex in the fence feature is annotated with its station, offset and elevation.

15 Close the Annotate Feature tool.
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Profile Display Parameters

The Surface Features > Settings > Profile Display area on the Edit Style dialog box 
specifies how each feature style is displayed in a profile view drawing. There are four 
parameters as described below.

Projected Line Segments – When enabled, the linear component of the active 
surface feature is displayed in the profile view using the Create Profile and Update 
Profile tools. Features with connected points such as breaklines and interior 
boundaries have a linear component. An example of a linear feature is a water line 
feature.

By default, all enabled features are projected onto the profile no matter how far the 
feature is located from the profile centerline. However, the Create Profile and Update 
Profile tools both have the ability to restrict the features that are projected onto the 
profile by specifying a bandwidth. Only those features inside the bandwidth are 
projected onto the profile.

When disabled, linear features are not displayed in the profile view.

Projected Points – When enabled, the point component of a feature is displayed in 
the profile view using the Create Profile and Update Profile tools. All features have 
point components. random features have a point at each coordinate value. Linear 
features, such as breaklines, interior boundaries, and exterior boundaries, have 
point components at each vertex.

By default, all enabled features are projected onto the profile no matter how far from 
the profile centerline the feature is located. However, the Create Profile and Update 
Profile tools both have the ability to restrict the features that are projected onto the 
profile by specifying a bandwidth. Only those features inside the bandwidth are 
projected onto the profile.

When disabled, point features are not displayed in the profile view.

Crossing Points – When enabled, a point element is created in the profile at the 
location where a linear feature crosses the profile.

When disabled, the point element is not created at the location where a linear feature 
crosses the profile.

Annotation – When enabled, features can be annotated in the profile view using the 
Annotate Features in Profile tool.

When disabled, features cannot be annotated.
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EXERCISE: CREATE PROFILE WITH FEATURES

Continue from the previous exercise.

1 Zoom out the graphics so there is room above the planimetric data to draw a 
profile.

2 Select the Create Profile tool (Evaluation > Profile > Create Profile).

3 Select the Profile > General leaf.

4 Enable Existing Ground, Disable all other surfaces

5 Select the Profile > Source leaf.

6 Set the following parameters.

Create: Window and Data

Source: Alignment, Mainline

7 Select the Profile > Include leaf.

8 Enable the Projected Features parameter.

9 Click Apply.

10 Locate the lower left corner of the profile above the left end of the planimetric 
graphics and click the data button.

The profile is generated.

The dashed green line is the triangulated surface of the model. The blue line is 
the projected water line feature.

11 Click Close.
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Cross Section Display Parameters

The Cross Section Display area specifies how each feature can be displayed in a 
cross section. There are five parameters as described below.

Projected Line Segments – When enabled, the linear component of the active 
surface feature is displayed in the cross section. Features with connected points 
such as breaklines and interior boundaries have a linear component. An example of 
a linear feature is a water line feature.

By default, all enabled features are projected onto the cross section no matter how 
far the feature is located from the centerline. However, the Create Cross Section and 
Update Cross Section tools both have the ability to restrict the features that are 
projected onto the cross section by specifying a bandwidth. Only those features 
inside the bandwidth are projected onto the cross section.

When disabled, linear features are not displayed in the cross section.

Projected Points – When enabled the point component of a linear feature is 
displayed in the cross section at the location where the feature intersects the cross 
section using the Create Cross Section and Update Cross Section tools.

When disabled, linear features intersecting the cross section are not displayed.

Crossing Points – When enabled, a point element is created in the cross section at 
the location where a linear feature crosses the cross section.

When disabled, the point element is not created at the location where a linear feature 
crosses the cross section

Annotation – When enabled, features can be annotated in the cross section using 
the Annotate Cross Section tool.

When disabled, features are not annotated.

Components – When enabled, surface components created by the Roadway 
Designer can be displayed in the cross sections.

EXERCISE: CREATE CROSS SECTIONS WITH FEATURES

Continue from the previous exercise.

1 Zoom out the graphics so there is room to the right of the planimetric data to draw 
cross sections.

2 Select the Create Cross Section tool (Evaluation > Cross Section > Create 
Cross Section).

3 Select the General leaf.
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4 Set the following parameters.

Create: Window and Data

Interval: 25

Offset Left: -50

Offset Right: 50

Surfaces: Enable Existing Ground, Disable all other surfaces

5 Select the Source leaf.

6 Set the source Alignment to Mainline.

7 Select the Include leaf.

8 Enable the Crossing Features parameter.

9 Click Apply.

10 Locate the lower left corner of the cross sections to the right of the planimetric 
graphics and click the data button.

The cross sections are created.

11 Click Close.

12 Zoom in on the cross sections and review the results. Notice the fence symbol at 
the location of the existing fence line, the water line symbol, and the telephone 
line symbol.

Cross Section showing fence, telephone line, and water line features

Did you notice InRoads ability to represent a feature differently in each of the views?

The water line is drawn in the plan, profile, and cross section views. In the plan and 
profile views it is a line string and in the cross section it is a oval. The fence line and 
the telephone line also differ between the plan view and the cross section view. 
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Named Symbology

So far we have learned how the feature name is stored in the DTM (surface) and 
linked to the surface feature. The surface feature then defines which components of 
the feature are displayable in the plan, profile, and cross section views. The final 
piece to the puzzle is how the graphic symbology is defined. The symbology is 
defined using a named symbology.

The named symbology definitions are stored in the .xin preference file along with the 
surface and survey features. Named symbology definitions are created and edited 
using the Named Symbology Manager tool (Tools > Named Symbology Manager).

Named Symbology Manager dialog box
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Select a named symbology and click Edit, or double click on the named symbology 
to access the Edit Named Symbology dialog box.

Edit Named Symbology dialog box

The named symbology definition is separated into 12 categories. The definitions are 
grouped into four sub categories; Default, Plan, Profile, and Cross Section. Within 
each sub categories is a definition for Lines, Text, and Points.

Double clicking on any category opens a dialog box where appropriate symbology 
settings are defined. For example, the Line settings define level, color, weight, and 
line style. The Text settings include font and other text parameters. The Point
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symbology settings define how a point is displayed. Points are displayable as cells, 
symbol fonts, or several built in shapes.

When an InRoads tool draws graphics, it looks to the named symbology category 
that most closely matches the type of graphics being drawn. InRoads first attempts 
to locate the symbology using the Plan, Profile, or Cross Section definitions. If the 
appropriate definition (line, text, or point) exists it is used. However if the definition is 
set to “Not Initialized”, it then reverts to the Default category. If the Default category is 
also “Not Initialized”, no graphics are created.

For example, when plotting an intersecting feature on a cross section, InRoads first 
looks to the Cross Section Point definition. The symbology in this definition is used if 
it exists. If the definition is “Not Initialized”, InRoads reverts to the Default Point 
definition and uses the symbology defined there. If the Default Point definition is also 
“Not Initialized”, no graphics are created.
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EXERCISE: CHANGE FEATURE ANNOTATION SYMBOLOGY

Continue from the previous exercise.

The goal of this exercise is to update the feature annotations put on the fence 
feature in an earlier exercise to the color red.

1 Zoom into the graphics so you can easily see the fence feature and the 
associated annotations.

2 Select the Named Symbology Manager tool (Tools > Named Symbology 
Manager).

3 Locate and select the FENCE LINE named symbology.

The fence feature is linked to the FENCE LINE feature style that is in turn linked 
to the FENCE LINE named symbology. Therefore, updating the FENCE LINE 
named symbology will influence the FENCE LINE feature.

4 Click Edit.

The Edit Named Symbology dialog box appears.

5 Double click on the Plan Text definition.

The Text Symbology dialog box appears.

Text Symbology dialog box

6 Set Color to Red.

7 Click OK to close the Text Symbology dialog box.

8 Click Apply on the Edit Named Symbology dialog box.



© 2006 Bentley Systems, Incorporated 52

2006 BE Conference
The Power of InRoads Features

9 Click Close on the Edit Named Symbology dialog box.

10 Click Close on the Named Symbology Manager dialog box.

11 Select the Annotate Feature tool.

12 Click Apply.

The fence line features update to a red color.

13 Click Close.

Feature Filter
Feature filters are selection sets of features based on a set of rules. The purpose of 
feature filters is to limit the features avilable to InRoads tools. When a feature filter is 
active, the InRoads tools will only display and operate on those features that satisfy 
the feature filter, not all of the features in the surface.

Feature filters are defined with the Feature Selection Filter tool (Surface > Feature > 
Feature Selection Filter). 

Feature Selection Filter dialog box
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The filter is defined by including or excluding features by creating rules. Each rule 
states that features satisfying a particular attribute, such as feature name, feature 
description, feature style, and feature type, are either included or excluded in the 
filter.

As rules are added to the filter, they are listed in the Rules section of the dialog box. 
The Current Results portion of the dialog box shows which features in the active 
surface satisfy the active filter.

The order of the rules is significant. The rules are processed from top to bottom, and 
the first rule is always determined by the Start With parameter. The Start With 
parameter defines if all features are included or excluded from the filter before any 
rules are applied.

Feature filters can be saved and recalled later for use with most of the InRoads tools 
that operate on features. 

Although any number of filters can be saved, there is only one active feature filter at 
a time. The active filter is set using the Filter Name parameter on the Feature 
Selection Filter dialog box or the Filter list on the Locks toolbar. The filter list is the 
pick list on the left end of the toolbar.

Locks toolbar

Feature filters work in conjunction with the Feature Filter Lock. The Feature Filter 
Lock is the leftmost lock on the Lock toolbar. When the Feature Filter Lock is 
enabled, only the features that pass the active feature filter are listed in dialog boxes. 
In addition, only features that satisfy the feature filter can be located in the graphics 
file when using a target button. If the Feature Filter Lock is disabled, InRoads 
behaves as if there is no feature filter defined.

EXERCISE: CREATE A FEATURE FILTER

Continue from the previous exercise.

This exercise builds a feature filter that includes only features that are not part of 
the triangulated surface model.

1 Delete all existing planimetric elements in the graphics file.

2 Select the Feature Selection Filter tool (Surface > Feature > Feature Selection 
Filter).

3 Set the Start With parameter to None.
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The filter will start with no features and add only those features that satisfy the 
rules.

4 Select Exclude from Triangulation from the Attributes field.

5 Set the Value parameter to True.

6 Set the Mode parameter to Include.

7 Click Add Rule.

The Current Results list updates showing the features that satisfy the filter.

8 Click Save As.

9 In the Name field, enter DNT Features.

10 Click OK.

11 Click OK to close the Feature Selection Filter dialog box.

The new filter is automatically set as the active filter.

EXERCISE: DRAW FEATURES WITH FEATURE FILTER

Continue from the previous exercise.

1 Enable the Feature Filter Lock.

2 Select the View Features tool.

The list of features in the dialog box is automatically restricted to those features 
that pass the active feature filter.

3 Enable and disable the Feature Filter Lock and observer how the list of available 
features changes in the dialog box. 

4 Make sure the Feature Filter Lock is enabled before continuing.

5 Click Apply.

The features that satisfy the feature filter lock display.

6 Click Close.

7 Disable the Feature Filter Lock.

Most dialog boxes that use features include a button named Filter. The Filter button 
is a shortcut to the Feature Selection Filter tool.
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Creating a DTM
In many workflows, the raw survey data is not available. Therefore, the DTM cannot 
be created as described in the previous chapter. Instead, the terrain data may be 
available in a graphical or an ASCII text format.

InRoads includes several import options to create surfaces from data sources other 
than raw survey data.

The Import Surface tool (File > Import > Surface) is used to import non-ASCII data 
into a DTM. The dialog box has three tabs across the top corresponding to the three 
types of non-ASCII data that can be imported.

All of the methods are similar in specifying the feature parameters such as name, 
type, and style. The Import from Graphics tool is described below.

The Text Import Wizard tool (File > Text Import Wizard) is used to import ASCII data 
into a DTM. This course does not discuss the Text Import Wizard tool.
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From Graphics
The Import Surface tool, From Graphics tab, is use to import graphical elements into 
an InRoads DTM.

Import Surface from Graphics dialog box

Using this tool, graphical elements are loaded as features into a surface. Once all of 
the features are loaded, the surface is triangulated. Each of the parameters on the 
dialog box is discussed below.
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Surface – Name of the surface the features are loaded into. The surface must exist 
prior to using the import tool.

Load From – The graphic elements to be loaded are selected as a single element, 
all elements on a level, or all elements inside a fence. A selection set can also be 
used. When the parameter is set to single element and a selection set exists, the 
elements in the selection set are loaded automatically.

Elevations – Specifies how the elevations of the imported graphics are defined. The 
Use Element Elevations option uses the elevations from the imported graphics. 

The Use Text options causes InRoads to read the value of the text as the elevation of 
the feature. 

Finally, when additional features are being added to an existing surface that has 
been previously triangulated, the imported feature can be draped onto the existing 
surface to determine the elevations. This is done using the Drape Surface option.

Thin Surface – When enabled, the thinning algorithm checks the deflection angle 
between the consecutive line segments of the input element. If the deflection angle is 
less than the specified tolerance value, the middle point is discarded. 

Use Tagged Graphics Name – When enabled the import process reads the feature 
style and point type from the tag data if the graphics being imported are tagged with 
the InRoads feature tag (inciv_ftr). If the graphics do not have tag data, or this 
parameter is disabled, the feature style and point type are defined by the respective 
fields on the dialog box.

Seed Name – The seed name is the feature name that is created in the surface 
model for each imported graphic element. However, since more than one graphic 
element is typically loaded at a time, this parameter specifies the base name of the 
feature. InRoads automatically appends a sequential number to the end of the base 
name thus making each feature name unique.

Feature Style – The name of the surface feature style that the imported features are 
linked to.

Point Type – The type of feature (breakline, random, …) that the imported feature is 
stored as in the surface.
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Maximum Segment Length – When enabled, specifies the maximum segment 
length any linear feature can have between two vertices. If the segment length 
exceeds the defined value, additional vertices are automatically added along the 
segment until the segment length is below the maximum allowed length. If disabled, 
any segment length is allowed.

Point Density Interval – Specifies the maximum length of any triangle leg 
generated from the feature. If enabled, additional vertices are added until the triangle 
leg length is below the specified density interval. If disabled, no additional vertices 
are added.

Exclude from Triangulation – When enabled, the feature is loaded into the surface 
but is not included in the triangulation process.

Summary
The following diagram summarizes the flow of data and feature elements through the 
InRoads and InRoads Survey software.

Summary of flow of InRoads DTM data and related feature definitions
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4 Using Features in Design

Features are a major component of the InRoads design process, especially when 
using more advanced design techniques.

In this chapter you will:

• Learn how Roadway Designer uses features.



© 2006 Bentley Systems, Incorporated 60

2006 BE Conference
The Power of InRoads Features

Roadway Designer
The Roadway Designer creates surface models of the design roadway surface. As 
we learned earlier, all data stored in a surface must exist in features. Therefore, the 
Roadway Designer creates features.

The features created by the Roadway Designer are named based on the Point 
Names assigned in the template definition. Template Points are definitions that 
include a name and a link to a feature style. 

When the results of the Roadway Designer are saved to a surface, the point names 
become the name of linear features in the surface. The features run parallel to the 
roadway connecting matching template points from one template drop station to the 
next. For example, a linear feature is created for each lane line, the edge of 
pavement, ditch foreslopes, ditch bottoms, and so on. 

Recall that the feature style links to a named symbology that defines the graphical 
appearance of the feature when displayed in the graphics file. Therefore, the point 
names control how each segment in the template is stored in the surface model and 
displays in the graphics file.
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EXERCISE: DISABLE DISPLAY OF EXISTING FEATURES

Continue from previous exercise.

Before beginning any design, we will toggle the display of the existing features off 
so that they do not interfere with the design graphics

1 Select the Level Display tool (Settings > Level > Display on the MicroStation 
menu).

The introduction of unlimited named levels in MicroStation V8 is a great 
improvement that permits organizations to better implement their standards. 
However, having a great deal of levels also makes it difficult to enable or disable 
the display of individual levels. For example, the file in this exercise has over 200 
levels. Locating and disabling the display of levels one at a time would be too 
time consuming to be practical.

To address this problem, MicroStation V8 includes level filters.
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2 Set the Show Level option button near the top of the Level Display dialog box to 
Filters. The result is the following dialog box.

The lab file includes two filters, one for the Existing Features and another for the 
Proposed Features. Enabling or disabling the level filter enables or disables the 
display of all levels that belong to the level filter.

3 Enable the Proposed Features filter.

4 Disable the Existing Features filter.

The graphic display updates to show only the proposed features. The proposed 
featuers include the profile and cross section elements.

5 Close the Level Display dialog box.
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EXERCISE: ROADWAY MODELER

Continue from the previous exercise.

1 Select the Roadway Designer tool (Modeler > Roadway Designer).

The Corridor has already been setup with the correct template and template 
drops.

2 Verify that the Active Surface is to Existing Ground.

Roadway Designer Active Surface definition

3 Click Process All to create the proposed road design.
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4 Click Create Surfaces to save the proposed road design to a surface.

The Create Surface dialog box appears.

5 Set the following parameters.

Name: Design

Default Preference: Proposed

Empty Design Surface: Enabled

Add Exterior Boundary - Style: Enabled, Exterior Boundary

Triangulate: Enabled

Display Features in Plan View: Enabled

All Other Settings: Disabled
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6 Click Apply.

The surface Design is created.

7 Close the Create Surface dialog box.

8 Close the Roadway Designer.
9 Select the Feature Properties tool.

10 Select Design from the Surface field.

11 Review the features in the surface.

12 Close the Feature Properties dialog box.
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